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This Month’s General Meeting  
Tuesday, October 13, 2020  

will Start at 3:00 P.M. 
FFG Christ Lutheran Church 

Note: 

Mask wearing and social distancing is 
mandatory during the meeting.  
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Winter Hours  star t at 3:00 P.M. (October through March) 
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Location:  Christ Lutheran Church 

481 Snead Drive, Fairfield Glade TN 

October 13th Presentation @ 3:00 P.M. 

Physical and Electronic Computer 
Clean-up 

Keeping your computer clean both physi-
cally and electronically is essential to mini-
mize problems during use.  

Physical cleaning is ensuring that your 
computer is free of “dust bunnies”, and that 
all components are properly seated.  

Electronic cleaning is removing “junk 
files” so the computer will work as fast as 
possible.  

Carl Nordeen will show us how to do both. 

Monday, October 12 2020 

 

mailto:www.PPCUGinc.com
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Join the Club! 
Anyone interested to attend the general meeting or any of 
the SIG meetings as a guest will be charged $3.00 per per-
son for any or all meetings in that month. Afterwards, you 
are encouraged to become a member of the Plateau PC 
Users Group.  Our Club cannot exist without you, the 
members.  
  
Membership Dues  
Note: Due to the limitations of COVID-19, our annual 
dues have been reduced effective 8/12/2020.  Our annual 
dues are now payable July 1st. of each fiscal year.   
Reduced annual 2020 - 2021 dues are $15 per single per-
son / $20 per family.  Persons/families joining  
during the fiscal year have dues payable as follows: 
 

 
 
 

 
BOARD OF DIRECTORS DISCLAIMER 

All members of the Plateau PC Users Group are willing 
to help one another in the area of advice and tutorial in-
struction over the phone.  If you should require more in-
volved services or instruction, we have a few members 
who are very knowledgeable in several areas.  As a re-
sponsible  
consumer, it is up to you to discuss, before retaining a 
member, any and ALL charges for repair services and 
time consuming tutorial activities. 
 
It is not the desire of this Board of Directors to set fees 
for individuals for services rendered, nor the responsibil-
ity to intervene between members who enter into a con-
tract among themselves. 
 
The GAZETTE is published using the following:  Mi-
crosoft Word, Microsoft Publisher, and Microsoft Win-
dows.  The Gazette is the monthly newsletter of the Plat-
eau PC Users Group, Inc. 
 
DISCLAIMER:  No warranty, express or implied, is 
made by the PPCUG, the Gazette editorial staff or its 
contributing editors.  This extends to all losses incidental 
or consequential from the use or non-use of any infor-
mation in any issue of the Gazette. 
 
All images used in the newsletter, website, blogs, class 
materials or handouts (“media”)  are obtained from a “free 
use” source, preferably images that have been released as 
“CCO Public Domain”. 

 
2020-2021 PPCUG, Inc. Board Members 

 Join In 
July - 
Sept 

Oct - 
Dec 

Jan - 
Mar 

Apr - 
June 

Single $15 $15 $12 $6 

Family $20 $20 $15 $7 

President Steve Rosenstein (931) 742-0151 

Vice-President/  
Compliance  

Jim Buxton (931) 456-6009  

Treasurer John Krueger (931) 707-3677 

Acting Secretary Richard Del Frate (931) 456-2251 

Past President Carl Nordeen  (931) 456-5597 

Membership John Krueger (931) 707-3677 

Publicity Mary Anne Nordeen  (931) 456-5597 

Gazette Editor Gordon Botting (931) 456-2184 

APCUG Rep  Steve Rosenstein (931) 742-0151 

Equipment  
Custodian 

 Bob Willis (931) 456-6511 

Webmaster Alan Baker  (931) 239-0877 

   

Directors at Large 

Gordon Botting Richard Del Frate Barbara Duncan 

Charlie Merrick Bob Willis  

   

Printed by, Business Equipment Clinic 
539 West Ave. Suite 101  Crossville TN 38557 
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The next General Meeting of the 
PLATEAU PC USERS GROUP 

Tuesday, November  10, 2020  
Note: Winter Hours 3:00 P.M. 

 

 

** Visit the PPCUG Website ** 
At: www.PPCUGinc.com. 

 
Read all about our club activities and scheduled monthly meetings, also current and past issues of the  Gazette 
Newsletter. Links also to the Meeting Handouts on past presentations. 
 

Send your comments and suggestions to the PPCUG Webmaster, Alan Baker 
jackal33980@gmail.com  (931) 239-0877 

Cool Tips & Sites 

Memory Troubles 

Faulty memory can cause all kinds of off computer behavior, and not only are memory problems behind 
odd issues, but they can also be difficult to detect, too. Luckily, Windows has a RAM checker that can help 
identify issues. Go to Start, type Memory, and then click on the Windows Memory Diagnostic link. 
 

 

 
 
Windows will reboot your computer, run a check of your memory, and let you know if it detected any 
problems. 
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How to Never “Safely Remove” a USB Drive Again on Windows 10 

BENJ EDWARDS   
 

 
 

Do you always “eject” your USB drives before unplugging them? You can save yourself some clicks—
and some time—with these simple tips, because you’ll never have to eject a flash drive again. 

Always Make Sure a Drive Isn’t in Use Before Unplugging 

Generally, the biggest threat to data when removing a USB drive (like a thumb, hard drive, and so on) is 
unplugging it while data is being written to it. This interrupts the write operation, and the file that was 
being written or copied will be incomplete or could remain as a corrupted file. 

So, before you ever unplug any USB drive from your PC, make sure all files have finished copying or 
saving to it. 

Of course, sometimes, it’s difficult to know whether your computer is writing to a drive. A background 
process could be writing to it, or a program could be autosaving to it. If you unplug the drive and inter-
rupt these processes, it could cause a problem. 

The only way you can avoid this is by “safely” removing the drive. However, Microsoft insists that as 
long as the “Quick Removal” system policy is selected, and you aren’t writing data to a drive, you don’t 
have to eject it. 

You’ll also need to make sure write caching isn’t enabled for the drive, but more on that in a moment. 

Get a Drive with an LED 

 
It’s easy to see when some USB drives are in use because they have a built-in LED that flashes when data 
is being read or written. As long as the LED isn’t flashing, you can safely unplug the drive. 

If your drive doesn’t have an LED, just do your best to make sure a background backup or copy operation 
isn’t in process before you remove it. 

Mandatory: Activate Quick Removal Mode in Device Manager 

By default, Windows 10 optimizes USB drives so you can remove them quickly without having to use the 
“Safely Remove Hardware” notification icon. It does this by disabling write caching. 

(Continued on page 5) 
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Write caching can speed up the appearance of USB disk writes, but it might also make you think a write pro-
cess is complete when it’s really still running in the background. (This became the default policy 
in Windows 10’s October 2018 update, also known as version 1809.) 

Since it’s possible to turn write caching back on in Device Manager, you should ensure it’s disabled if you 
want to quickly remove your USB drive without ejecting it in the future. 

To do this, click the Start button, type “Device Manager” in the Search box, and then press Enter. 

 

Click the arrow next to “Disk Drives,” right-click the external USB drive, and then select “Properties.” 

 

Under the “Policies” tab, select the radio button next to “Quick Removal” (if it’s already selected, just leave 
it that way), and then click “OK.” 

 

Close “Device Manager” and you’re all set! In the future, you can safely remove that particular USB drive 
without ejecting it whenever a write operation isn’t in progress 
 

(Continued from page 4) 
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Windows 10 Keyboard Shortcuts to Increase Your Productivity 

General Keyboard Shortcuts 
 

 

Shortcut Action 

Ctrl + C To Copy the selected text, image, or other items 

Ctrl + V To Paste the copied text, image, or other items 

Ctrl + X To move/cut the selected text, image, or other items 

Ctrl + Z To perform the undo action 

Alt + Tab Toggle between running apps 

Windows Icon+ L To lock your system 

Windows Icon+ D To display or hide the desktop 

Alt + F4 Close the current window of any application or folder 

F2 To rename the currently selected item 

F3 Perform a search in the File Explorer for a file or folder 

F4 Display the address bar list in File Explorer. 

F5 Perform a refresh in the active window 

F10 Activate the menu bar 

Alt + F8 Display your password on the sign-in screen 

Alt + Enter Full-screen mode 

Ctrl + F4 Close the active document 

Ctrl + A Select all item in a folder or whole text in a document 

Ctrl + D To delete the selected item and transfer it into recycle bin 

Ctrl + R To refresh the currently active window 

Ctrl + Y To redo an action 

Ctrl + Right arrow Move the cursor to the starting of the next word 

Ctrl + Left arrow Move the cursor to the starting of the previous word 

Ctrl + Down arrow Move the cursor to the starting of the next paragraph. 

Ctrl + Up arrow Move the cursor to the starting of the previous paragraph. 

Ctrl + esc Open the Start Menu 

Ctrl + Shift + esc Open the task manager 

Shift + any arrow 
key 

Select more than one item in a folder or on the desktop, or select text in a docu-
ment. 

Shift + Delete Permanently delete an item 

Windows icon + 
PrtScn 

Take a screenshot of the whole screen 
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How to Copy Files to a USB Flash Drive on Windows 10 

BENJ EDWARDS   

 

If you’d like to copy files to a USB flash drive on Windows 10—perhaps to back them up or transfer them to 
another computer—it’s easy to do using File Explorer. Here’s how. 

First, Locate the USB Drive on Your PC 

Before we can copy any files, we need to make sure the flash drive is connected and ready to receive data. 
First, plug your USB flash drive into a USB port on your Windows 10 PC. Give your PC a minute to recog-
nize the drive and automatically install any needed drivers for it. (These instructions will work for other  

external storage devices, too, including SD cards and USB hard drives.) 

Then open the Start menu, type “This PC,” and hit Enter. This is a direct shortcut to a list of drives attached 
to your PC in File Explorer. 

 

In the window that pops up, locate the section called “Devices And Drives.” If necessary, click the small 
carat-shaped arrow to the left of the section header to reveal a list of the drives. 

 

(Continued on page 8) 



Gazette October 2020    www.PPCUGinc.com                                                    Page 8  

If your USB drive has been recognized correctly and is ready to receive files, it will appear in this location 
with a name and a drive letter assigned to it, such as “D:”, “E:”, or “F:”, or another letter. Note that the “C:” 
drive is almost always the main drive on your PC, unless you go very out of your way to change it. 

Depending on how File Explorer is configured (see the “Layout” options under the “View” menu), the style 
of the icons within this window may appear different on your machine. But the drive should still be there. 

 

If the USB drive doesn’t show up in your “Devices And Drives” list, you’ll have to perform some in-depth 
sleuthing to figure out what it going on. 

RELATED: How to Find Your Missing USB Drive in Windows 7, 8, and 10 

Find the Files You Want to Copy 

While keeping the USB drive window open, press Ctrl+N to open a new File Explorer window. Use the 
new window to locate the files you would like to copy. 

After you’ve located the files, return to the “This PC” window and double-click the USB drive icon to open 
it. You should now have two windows open side by side. 

 

What happens next depends on how you’d like to copy the files. There are several ways to do it, but here are 
the two most common methods. 

 

(Continued from page 7) 
 

(Continued on page 9) 
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How to Copy Files by Dragging and Dropping 

Using your mouse cursor, select the file (or files) you would like to copy, then click and hold the mouse but-
ton to drag the files to the USB thumb drive window. 

 

When an icon representing the file or files appears over the destination window, release the mouse button, and 
the files will be copied to that location. 

 

In the future, you can also drag files directly onto the USB flash drive icon in “This PC” to copy them to that 
location. 

How to Copy Files Using Copy and Paste 

You can also copy files in Windows using the Clipboard. Using your mouse cursor, select the file (or files) 
you would like to copy, then right-click on the selection. In the menu that pops up, select “Copy.” 

 

(Continued from page 8) 
 

(Continued on page 10) 
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Place your mouse cursor over a section of blank space within the USB thumb drive window and right-click 
again. In the menu that pops up, select “Paste.” 

 

The files you “copied” to the Clipboard earlier will be copied onto the USB flash drive. 

 

Congratulations: Your files are now on the USB drive. You can unplug it if you’d like. It’s a good idea to 
“Safely Remove” (or eject) the drive before you do. 

RELATED: How to Copy, Cut, and Paste on a Windows PC 

What to Do If You Run out of Space on the Flash Drive 

If you’re copying files to your USB flash drive and you receive a message such as “There is not enough 
space” or “There is insufficient disk space to complete the operation,” then you’ve run out of free space on 
your flash drive. 

 

There are three basic solutions. The first is to explore the contents of your USB flash drive and see if it  

(Continued from page 9) 
 

(Continued on page 11) 
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already contains data that you can delete to free up space. Be careful that you don’t delete anything that 
you haven’t already backed up somewhere else. 

The second solution is to purchase a larger USB flash drive. They are available on online shopping sites 
like Amazon.com and even at many pharmacy and grocery stores. USB drives with higher capacity usually 
cost more, but they can be a good investment if you need to transfer or back up a large amount of data. 

And if you are transferring files to another machine, the third solution is to break the transfer job into 
chunks. First, copy a few files to the drive, then copy them off to the new machine. After that, delete the 
previously copied files from the thumb drive and repeat with the next batch of files until you’re finished. 
Good luck! 

How to Delete a Page in Microsoft Word 

ByBen Stockton 

you’re editing a Word document, you may need to delete a page or two. 
Here’s how. 
 

Creating a new Microsoft Word document is a straightforward process. You can type, delete, rearrange, 
and reformat the content you write or insert pretty easily, including changing the default font your docu-
ment uses to create your own style. 
You may need to rearrange pages in Word if you’re making big changes, but if you end up with too 
much content, you may need to consider deleting entire pages. If you want to delete a page in Microsoft 
Word, here’s what you’ll need to do. 

Removing Blank Word Pages 
Occasionally, an empty additional page will appear at the bottom of a Microsoft Word document. This can 
be frustrating, especially when it comes to the printing stage. 
This is usually due to Word inserting an additional empty paragraph below the existing content. If the pre-
vious page is full, this empty paragraph will be pushed onto a new page. 
To delete it, you will need to be able to view paragraph marks on your document pages. You can show 
these by pressing the Paragraph Marks button, listed under the Paragraph section of the Home tab on 
the ribbon bar. 
Alternatively, pressing Ctrl + Shift + 8 on your keyboard will cause them to appear. 

 

(Continued from page 10) 
 

(Continued on page 12) 
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Once pressed, paragraph marks will become visible at the end of each paragraph in your document. 
On the additional empty page, you should see a paragraph mark visible. To remove the page, move your 
blinking cursor to the same position, then press the delete or backspace key on your keyboard. 
 

 

If this doesn’t remove the paragraph, double-click the paragraph mark to select it first, then press delete. 
This should ensure that the empty page is removed, with the blinking cursor moving to the end of your 
content instead. 

Using Find and Replace to Remove Pages With Content 
You can also delete entire pages with content already in place. This will delete all the content on the 
page. You can do this using the Find and Replace tool. 
Make sure that your blinking cursor is currently placed on the document you wish to delete. Once the 
cursor is in place, press the arrow next to the Find button, listed under the Editing category in 
the Home tab on the ribbon bar. 
From the drop-down menu, select Go To. Alternatively, press  Ctrl + G on your keyboard to bring up 
the same menu. 

 

In the Go To tab of the Find and Replace window, type /page in the Enter page number box, then 
press the Go To button. 
 

 

Doing this will select everything on the currently active page. With your content selected, press either 
the delete or backspace key on your keyboard to delete the page. 

 
 

(Continued from page 11) 
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Parts / Components of an Email Address 

 

An email address has three main components. For the sake of simplicity, this is how it can be demonstrated: 

accountname @ domain.com 

1) Domain name: This part of the email address is the name of server that hosts your emails. It is not nec-
essary that the domain name would always be of a .com kind. It can be anything from the standard list of 
domain extension (e.g. .org , .net , .gov, .co.in etc.) 

A server could that be of a free web-based email service provider (like Gmail, Hotmail, Yahoo! Mail etc.) 
or server may belong to a specific organization (for example, if you’re working in a company named XYZ 
… the server name could be xyz.com) 

2) Account name (or username): An email hosting server may host emails for one person —or millions of 
persons. You can imagine your account like a pigeon-hole or letter box whose key only you have. This key 
is called… yes, you guessed it right!… it’s called password ! Allow me to add a word of advice here. You 
should set your passwords to be strong. Weak passwords can compromise security of your email account. 

Having said that, let’s proceed… 

All the email account names on a server has to be unique so that the server can send emails to various ac-
counts without any confusion. There can not be two accounts with the same name on a server. Therefore, 
two techwelkin @ gmail.com are not possible. But techwelkin @ gmail.com and techwelkin @ ya-
hoo.com are possible. The account name (i.e. the part before @ sign) refers to the user/owner of the email 
address. 

3) @ Sign: First thing first, in case of email address, this symbol is pronounced as at and not as “at the 
rate” 

This symbol is used in an email address to separate account name from domain name. When a computer 
tries to understand an email address, it splits the address from @ sign. The part of email address that comes 
before @ is account name and the part that comes after it is domain name. Simple! 

There must be one (and ONLY one) @ sign in an email address. If the address does not have this sign —it 
is not a valid email address. 

Ok, now that we know the structure of email address, let’s understand a few more things: 

· Email addresses are not case-sensitive. This means it does not matter whether you write address in 
uppercase or lowercase or mixed case. (ONLY rarely the account name may be case-sensitive but 
domain name is never case-sensitive)…  All free web-based email services use non-case-sensitive 
addresses… Therefore:TECHWELKIN @ GMAIL.COM is same as techwelkin @ gmail.com 

· Conventionally, however, email addresses are written in small letters. But as said in previous point, 
it would not matter even if you write it in capital letters. 

· To show the account holder’s real name against an email id, the email id is enclosed in angular 
brackets. 
For example:Lalit Kumar <techwelkin @ gmail.com> 

· Account name can not be longer than 64 characters and domain name can not be, practically, longer 
than 254 characters. 
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How to Make Windows Task Manager Always Open a Specific Tab 

BENJ EDWARDS   

While using Task Manager for keeping an eye on your Windows 10 
PC, sometimes you end up using one tab (say, “Performance”) more than others. In that case, you can set that 
tab as one you see when you start Task Manager. Here’s how. 
First, launch “Task Manager.” In Windows 10, right-click the taskbar, and select “Task Manager” from the 
menu that pops up. 

If Task Manager launches with the simple interface, 
click “More Details” at the bottom of the window. 

In the full Task Manager window, click Options > Set default 
tab. A smaller menu will pop up listing the different tabs you can choose. Select the name of the tab you’d 
like to appear by default, and a check mark will appear beside it. 
You can make the Processes, Performance, App history, Startup, Users, Details, or Services tab your default. 

 
The next time you launch Task Manager, the default tab you chose will be on display. 
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Plateau PC Users Group, Inc.  
 

 Revised Application for Membership 
   
            ------- New Member    ------ Renewing Member 
 
Return this application with check foe annual dues payable to “PLATEAU PC USERS GROUP” Return to 
the club Treasurer during our meeting or mail to “PPCUG Treasurer. P.O. Box 3787, Crossville TN  38557” 
 
Note: Due to the limitations of COVID-19, our annual dues have been reduced effective 8/12/2020.  Our 
annual dues are now payable July 1st. of each fiscal year.   
Reduced annual 2020 - 2021 dues are $15 per single person / $20 per family.  Persons/families joining  
during the fiscal year have dues payable as follows: 
 

 
 
Date: --------------------               Amount Paid: $ --------------------   by Cash ------ , or Check (# ----------------------- ) 
 
--------------------------          -------------------------      -------------------------------------------- 
Last Name   First Name  Family Member (if family membership) 
 
------------------------------------------------------------------------------- 
Address: 
 
--------------------------------------        --------           ---------------    (-------------) ----------------------------- 
City     State  Zip Code Phone Number 
 
E-Mail address: ---------------------------------------------------------------------- 
    Please Print 
 
I have belonged to a Computer Club before:  Yes -----------     No ------------  
 
I have used PC’s since (year): ------------------  
 
I have knowledge in the following areas that I would be willing to share with club members: 
 

 
 

 
 

 
 
September 2020 

 Join In July - Sept Oct - Dec Jan - Mar Apr - June 

Single $15 $15 $12 $6 

Family $20 $20 $15 $7 
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November 2020 

Sun Mon Tue Wed Thu Fri Sat 

1 2 3 4 2:00 P.M. 

PPCUG Board 
Mtg.  

5 6 7 

8 9 10 3:00 P.M. 

General Mtg.  
Presentation. 
Followed By  
Q&A Session 

11 12 13 14 

15 16 17 18 19 20 21 

22 23 24 25 26 27 28 

29 30      


